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ProCheck 1 INTRODUCTION

1 Introduction

Thank you for purchasing the ProCheck by Decagon Devices. The
ProCheck interfaces with your analog and digital soil moisture sen-
sors to obtain instantaneous results. This manual covers all ProCheck
functions and capabilities.

1.1 Customer Support

There are several ways to contact Decagon if you ever need assis-
tance with your product, have any questions, or feedback. Decagon
has Customer Service Representatives available to speak with you
Monday through Friday, between 7am and 5pm Pacific time.

Note: If you purchased your logger through a distributor, please con-
tact them for assistance.

Email:
support@decagon.com or sales@decagon.com

Phone:
509-332-5600

Fax:
509-332-5158

If contacting us by email or fax, please include as part of your mes-

sage the instrument serial number, your name, address, phone, fax
number, and a description of the problem or question.

1.2 About This Manual

Please read this manual before operating your logger to ensure that
it performs to its full potential.
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1.3 Warranty

The ProCheck has a 30-day satisfaction guarantee and a one-year
warranty on parts and labor. Your warranty is automatically vali-
dated upon receipt of the instrument.

Note: The one year service plan activates when Decagon ships the
instrument and not at the time of software installation.

1.4 Seller’s Liability

Seller warrants new equipment of its own manufacture against de-
fective workmanship and materials for a period of one year from the
date of receipt of equipment.

Note: We do not consider the results of ordinary wear and tear,
neglect, misuse, or accident as defects.

The Seller’s liability for defective parts shall in no event exceed the
furnishing of replacement parts “freight on board” the factory where
originally manufactured. Material and equipment covered hereby
which is not manufactured by Seller shall be covered only by the
warranty of its manufacturer. Seller shall not be liable to Buyer for
loss, damage or injuries to persons (including death), or to property
or things of whatsoever kind (including, but not without limitation,
loss of anticipated profits), occasioned by or arising out of the instal-
lation, operation, use, misuse, nonuse, repair, or replacement of said
material and equipment, or out of the use of any method or process
for which the same may be employed. The use of this equipment con-
stitutes Buyer’s acceptance of the terms set forth in this warranty.
There are no understandings, representations, or warranties of any
kind, express, implied, statutory or otherwise (including, but with-
out limitation, the implied warranties of merchantability and fitness
for a particular purpose), not expressly set forth herein.
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2 About the ProCheck

The ProCheck is a handheld readout device for use with all soil
moisture sensors and environmental monitoring sensors made or sold
by Decagon.

2.1 Specifications

Battery Type: 4 AA Batteries

Battery Life: 500-1000 Hours Expected
Connector Type: Stereo Plug (3.5mm)
Memory: 5000 individual readings

Components

ProCheck Handheld Reader
Serial (RS-232) to USB Cable
Operator’s Manual

Optional - Pigtail Adapter
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2.2 The Buttons

Menu: Menu turns on the ProCheck and cy-
cles through the menus at the top of the screen.
Holding Menu down for 3 seconds powers off the
ProCheck. Pressing Menu in an annotation/edit
screen returns you to the previous screen.

Arrow Keys: These scroll through sensors,
menu options, and change characters or num-
bers in the annotate/edit menus.

Escape: cancels setting changes, cancel read-
ings, and scroll to the left in an annotation/edit
menu.

EnterAllows you to choose options within
menus, start readings, and scroll to the right
in an annotation or edit menu.

Save Saves Instrument and Annotation set-
tings.

SAVE

B) | JON|[ R0,
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3 The Menus

3.1 The Main Menu

The ProCheck features three main menus designed for ease of use.
The Main Menu appears when you power up the ProCheck and allows
you to take measurements with Decagon sensors.

Active Tab Inactive Tabs Battery Level
\ ~. |
. JMeazurement || D
v ¥alE Hnisture,Temg,ED

0.247 m¥/m
o >
0.0 bulk d5/m
Wvi1E Minetal “Is
|

Sensor Version Calibration Type Live Updating

Changing Your Sensor

Change the sensor type by pressing the up and down arrow keys
if the sensor list spinner is available.

Note: You can customize the sensor units and calibrations in the
Configuration Menu. The sensor versiton is only shown if the ProCheck
was able to retrieve sensor information directly from the sensor. A
soil calibration type displays only if it is available for that sensor type.

Taking a Reading
To take a reading, scroll through the sensor list until you find the

sensor type you want to read. Plug the sensor into the stereo jack
on the top of the ProCheck.
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Press Enter to engage the live update mode. In live update mode, a
live updating icon displays in the lower right corner during updates.
The ProCheck continuously updates the screen with the latest sensor
reading. Press Enter again to restart the sensor. Press Esc to exit
the live update mode. Press Save to save the current reading on the
display and annotate your readings.

Annotating a Reading

Once you have taken a reading, press Save to show the Annotate
screen. The left side of the screen shows a reading summary and the
right side of the screen shows the annotation field as well as the date
and time of the reading.

Annotate MEHU to exit
5TE Moisture, Temp EC

EI:IHF'LE 0121 I'I'IE."'I'l'l3

_____ S 25.4°C
Sep 12, 2012 0,00 bulk d5/m

15:32:25h Mineral

Use the up and down arrow keys to change the current character and
use the left and right arrows to change the cursor position. Press Save
to save the annotation and Menu to return to the Main screen with-
out saving the record.

Note: The ProCheck remembers the last annotation stored into mem-

ory, use the arrows to clear all or part of any old annotations. This
clears all the characters to the right of the current cursor position.

3.2 The Configuration Menu

Navigate to the Configuration Menu, press Menu until highlighting
the Configuration tab. Several different options are available for
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customizing the instrument.

[JConfiquration [}
Unit=

Calibration Type
sensor List

50I-12 Addres=ss
Battery: S0%

, [ — ] H

_|:|I3-:-n+“|-;|ur'.at|-:-n (1] D
Time: 20051

Contrast W
About

Units Sub Menu

From this menu you can configure your unit preferences for various
unit types.

[JConfiguration [[] WD

Temperature: °C
Humidity: FH

ar'I:-:-nen: g .. ﬂ
Frecipitation: mm -

7
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Use the arrows to navigate to the correct unit and press Enter to
cycle through the unit options.

The “Show Unprocessed Data” option allows you to view any for-
matted data in its raw analog to digital count (ADC) state. When
you check this option, all data readings on the main and data screens
displays in an unprocessed format as seen on the following screen.
This is helpful when troubleshooting sensors or when creating your
own custom calibration. To save your changes, press Save. To cancel
without saving, press Esc.

[JConfiquration [[] WD
EC-20: Mineral =
EC-110: Mineral ﬂ

EC-5: Custom
ECHz0-TE: Mineral
EC-TH: Mineral

Calibration Type Sub Menu

Some sensors support a calibration adjustment for different media
types (soil, rockwool, etc.). The first screen shows a summary of the
selected soil calibrations for each configurable sensor.

|Heasurement [[]] WD
*o [E Moisture. Temp EC
434 (rawm WHIC)

Bl2 (raw temp)
0 (raw EC)
waen Unprocessed
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To modify the sensor calibration type, press Enter. You can choose a
preset soil calibration type or create your own (See creating a Custom
Calibration). To change the soil calibration type, select the medium
option and press Enter. You can view the calibration coefficients by
pressing Enter when the coefficients option is highlighted.

Press Save to save your calibration preference or press Esc to exit
without saving changes.

[JConfiquration [[] WO
sensor: STE ﬂ

Coefficients...

The following sensors support soil calibrations.
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Table 1: Sensors Supporting Soil Calibration

Sensor Name

Supported Medium
Calibrations

EC-5 Soil Moisture

Mineral, Potting/Peat,
Rockwool and Custom

EC-10 Soil Moisture

Mineral and Custom

10HS Soil Moisture

Mineral and Custom

ECH20-TE Moisture, Temp,
& EC

Mineral, Potting /Peat,
Rockwool, Perlite, and
Custom

EC-TM Moisture & Temp

Mineral, Potting /Peat,
Rockwool, Perlite and
Custom

5TE Moisture, Temp & EC

Mineral, Potting /Peat,
Rockwool, Perlite, and
Custom

5TM Moisture & Temp

Mineral, Potting /Peat,
Rockwool, Perlite, and
Custom

GS1 Soil Moisture

Mineral, Potting /Peat,
Perlite, Custom

GS3 Moisture, Temp & EC

Mineral and Soilless
Substrate

RS3 Moisture, Temp & EC

Mineral and Soilless
Substrate

Note: With the 5TE and 5TM sensors (only), custom calibration
equations must be constructed with e, (dielectric permittivity) as the
‘¢’ variable. With the ProCheck and other Decagon data acquisition
equipment, €, = Raw/50. With other data acquisition equipment, if
read in SDI-12 mode, £, = Raw/100.

10
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3.2.1 Custom Calibrations
Creating a Custom Calibration

You can create your own custom calibration for certain sensor types.
Custom calibrations apply directly to the raw analog to digital count
(ADC) in the form of a fifth order polynomial. For more information
on creating a custom calibration, please refer to the literature sec-
tion of our website at www.decagon.com for the Custom Calibration
Application Note.

Note: Custom calibrations are in terms of m3/m?®. ProCheck ap-
plies unit conversions after the custom calibration.

Entering a Custom Calibration

To enter your custom calibration into the ProCheck, navigate to the
Calibration Type Sub Menu (in the Configuration Menu) and select
a sensor. Press Enter until the medium type says Custom. Then
press Enter on the coefficient option to get to a summary screen like
the one below.

[JConfiquration [[] WD
JEHfeTragledoFecodehiey 3

b=+2.32E-02
c=-5.50E-04
d=+4.30E-0& -

Each coefficient corresponds to a letter in the polynomial above. Be-
low the polynomial resides the value of each coefficient in scientific
notation. To edit a coefficient, press Enter while highlighting the
coefficient. The Edit Screen appears to allow you to edit the coeffi-
cient.

11
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Edit MEMU to exit
ST+ oF e+ deFecotebiea
a =

h=+1 OOE+0]
ceeDDE-Q 2. 00E+00

d=s0O0E.DD T

Use the arrow keys to change the current value, use the left and right
arrow keys to change the cursor position.

Press Save to save the coefficient and Menu to return to the co-
efficient list without changing the coefficient.

Once you have changed all of the coefficients, press Save again to
save the custom calibration or Esc to return to the Calibration Type
Sub Menu without saving the calibration.

Sensor List Sub Menu

You can customize which sensors you would like available on your
Main screen.

[ JConfiguration
Check all

k

Uncheck all
SJEC-20 Sail Moisture
SLEC-10 Sail Moisture
SEC-5 Soil Moisture =

Navigate through the sensor list using‘’ arrows. To change the status
of a sensor, highlight it and press Enter. Each sensor name you check

12
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appears in the list on the Main screen. If it is unchecked it will
excluded. You can use the “Check All” or “Un-check All” options
to enable/disable all the sensors at once. Press Save to save your
changes or press Esc to exit without saving.

3.3 SDI-12 Address Menu
Intro to SDI-12

SDI-12 stands for serial data interface at 1200 baud. This stan-
dard interfaces battery powered data recorders (loggers) with micro-
processor based (intelligent) environmental data acquisition (EDA)
sensors. Please see www.sdi-12.org for more information on using

SDI-12.

Decagon’s digital soil moisture sensors communicate using both the
SDI-12 standard and Decagons proprietary protocol. This SDI-12
feature is not necessary when using Decagon sensors with Decagon
data loggers. But, SDI-12 may be useful if you are using the sensors
with other third party data acquisition systems such as Campbell
Scientific data loggers.

For more information, refer to the sensor Integrator’s Guide. One
feature of the SDI-12 protocol is the use of a single character sensor
address. This character may consist of “0” (default) to 1-9, a-z, or
A-7Z. This address is necessary when multiple sensors are installed at
a single site. This is important because you will need to assign each
sensor a different address to allow you to keep their data separate.

Setting SDI-12 addresses

You may use the ProCheck to conveniently assign SDI-12 addresses
to the Decagon digital sensor. To assign the addresses, follow steps
1 through 5.

1. Use the pigtail adaptor to connect a SDI-12 compatible sensor
to the ProCheck’s stereo jack.

2. In the Configuration menu, select SDI-12 Address to refresh

13
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the screen with the current sensor configuration.

[JConfiquration [[] WO
Addres=s: =2 3

Model: STE

Model YWer: .50

Wendaor: OECAGON
SOI-12 YWer: 1.3

3. Press the up and down arrows to select the new address from
“0” (default) to 1-9, a-z, or A-Z.

4. Press Enter or Save to accept the new address. The screen
refreshes to show the new address setting.

5. Press Esc or Menu to exit the SDI-12 Address Sub Menu.
Note: If you plan on setting addresses on multiple sensors, repeat the
steps 1 through 4 before proceeding to step 5.

Date and Time Sub Menu

To set the date/time on the instrument you can connect to ECH20
Utility and select the “Set Date/Time” option under the Actions
menu, or you can follow the instructions below to manually update
the date and time.

[JConfiguration [[] WD

Date: JEn 12 2012

14
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1. Scroll to the Date Option in the Configuration Menu and press
Enter. You should see a screen similar to the one above. A
pair of arrows is present above and below the first value.

2. Use the up and down arrow keys to change the current value.
Press Enter to move to the next value or press Esc to return to
the previous value. (Hold down the up/down arrows to scroll
quickly).

3. Press Save to save your changes.

Contrast Sub Menu

The Contrast Sub Menu allows you to alter the screen lighting con-
trast settings. Scroll to the contrast option in the Configuration
Menu press Enter. Use the arrows to change the contrast. Press Save
to save the contrast or press Esc to exit without saving changes.

[JConfiquration [[] WD

llse the UP and DOWN
arrows to change the
contrast lewel

L[ —

About Sub Menu

This menu displays the ProCheck serial number, device name, and
firmware version.

3.4 The Data Menu

To navigate to the Data Menu, press Menu until the Data Tab is
highlighted. Several different options are available within this menu.
The ProCheck can store up to 5,000 individual readings.

15
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[ 10ata |
Wigw

Oownload

Erase

) [ — H

5/ 5000

Number of Readings Taken Maximum Number of Readings

View Sub Menu

You can view a summary of your saved data or view detailed in-
formation about any data record. The first screen is a summary
screen and looks similar to the picture below.

[ 1 ]Data [ ]
03-17.15:32:25 5SAMFLE

059-17.15%:29:31,50IL 2B
03-17,15:28:48, 50IL 2A
09-17,15:27:30, RAINFALL
03-17.15:26:41

, [ — ] ﬂ

This page shows a data record list that includes the date and the
time that the reading was taken and the annotation (if any). To
view more information about an individual record, press Enter while
highlighting the record.

The left side of the screen shows a reading summary and the right
side shows the annotation, date, and time of the reading. From this
screen you can press Esc to return to the previous view screen or use
the up and down arrow keys to view more records in detail.

16
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3.4.1 Statistics
You can collect summary statistics, including average and standard
deviation, from measurements taken with the ProCheck. To collect

summary statistics on a series of measurements, go to the Statistic
menu.

[ [T ]5tatistics | D
*o 1 = n)

-0.026 m¥/m¥ 0.074 0057

231°C 231 0.1
-;'_’, Mineral n=4d

Use the arrows to select the correct sensor. When you press Enter,
the connected sensor will show you the current reading on the left
hand side of the screen.

Annotate MEHU to exit
5TH e lu )

SAMPLE 0074 0.057

Jan 12, 201z =+l 01
22:32:47h n =4

Each subsequent Enter keypress adds the current measurement to
the summary statistics. The “n” value represents the number of
measurements taken as part of the summary statistics. Press Esc
once to stop live updating and press Esc a second time to reset the

statistical information.

17
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You can save the summary statistics by pressing the Save button.
However, this does not reset the “n” value so you can continue
to make measurements. The Save button only saves the summary

statistics and not the data you use to calculate the values.
Downloading Data

Your ProCheck comes with ECH20 Utility software for Microsoft
Windows. The Utility makes downloading data to your computer
very easy. In general, you should use the ECH20 Utility to down-
load data instead of the Menu option in the ProCheck.

Note: You must install the USB driver before connecting the USB
Cable to your computer. You can install the driver from the USB in-
cluded with your ProCheck or download at www.decagon.com/support.

This menu option sends the data saved in the ProCheck to the ter-
minal software running on your computer.
1. Configure your terminal software with the following settings:

9600 baud

8 data bits, 1 stop bit, no parity

No software/hardware flow control
Append line feeds to incoming line ends

2. Connect your ProCheck to an available USB port on your com-
puter using the included RS-232 to USB cable.

3. Set your terminal software to capture received data if you want
to save the data.

4. Select “Download” from the ProCheck Data menu.
3.5 Erasing Data Memory

Caution: Once you activate this feature, all data is perma-
nently deleted from the ProCheck, and is not coverable.

Follow steps 1 through 3 to erase your data.

18
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1. Navigate to the Data Menu in the ProCheck.
2. Select the Erase option.

3. Press Enter on the Erase Data Memory screen.

19
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4 ECH20 Utility Software

Use ECH20 Utility as a software interface for downloading sensor
measurement data stored in your ProCheck. You can choose to save
your data as an Excel Workbook file, tab-delimited text file, and a
Raw, unprocessed data file. ECH20O Utility also helps you delete
measurement data stored in your ProCheck and set the date and
time in your ProCheck.

Note: Decagon designed ECH20 Utility to work with your ProCheck
and Decagon’s line of ECH20 loggers. Some non-applicable controls,
features and settings of ECH20 Utility are disabled when connected
to a ProCheck.

Minimum computer requirements:

Windows 98 or newer, including Windows 7
Available serial port (or USB-to-serial adapter)
MS Excel 97 or newer (if saving data as XLS files)

4.1 Installation

The ECH20 Utility installer software is located on the USB that
shipped with your ProCheck instrument.

You can also download the latest version of ECH20 Utility from
Decagon’s website: http://www.decagon.com /support/downloads.

Note: You must install the USB driver before connecting the USB

Cable to your computer. You can install from the USB drive included
with your ProCheck or download at www.decagon.com/support.

4.2 Connecting to your ProCheck

ECH20 Utility needs to establish a communication connection with
your ProCheck to perform any of its functions.

20
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Follow steps 1 through 4 to connect to your ProCheck.
1. Launch ECH20 Utility.

2. Use the supplied Serial to USB cable to physically connect your
ProCheck to an available USB port on your computer.

3. Choose the correct USB (COM) port from the Connect Via
control in the toolbar that matches the physical port you chose
in step 2.

4. Click the Connect button in the toolbar.

Once ECH20 Utility establishes a connection with the ProCheck,
you should see the ProCheck name, serial number, firmware version
and date and time settings.

1. Connect ECH20 Utility to your ProCheck.

2. Click the Download button in the toolbar. You can also choose
Download All Data from the Data Menu.

3. ECH20 Utility opens a standard File Save dialog. With this
dialog, you can name your data file, select where to save on
your computer, and choose a file format.

4. Click the dialog Save button to start the download. ECH20
Utility will show the progress of your download.

Note: You can cancel a download in progress using the Cancel button.
ECH20 Utility does not create a data file if you cancel the download.

4.3 Saved Data File Types

By default, ECH20 Utility saves measurement data as an Excel
Workbook file. Each of the file types are discussed below.

Excel Workbook (*.xls): ECH20 Utility saves your measurement
data on Sheet 1 with these six columns.

e Measurement Time: Date and time when the ProCheck made
the measurement.

21
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Sensor Name: Type of sensor used for the measurement.
Measurement 1: Primary measurements made by the sensor.
Measurement 2: Some sensors support two measurements.
Measurement 3: Some sensors support three measurements.

Sample ID: The optional annotation saved at the time of mea-
surement.

ECH20 Utility saves the raw data for each measurement on Sheet
2. This information includes the calibration coefficients used to cal-
culate your data (for applicable sensors).

You can use the raw data for the sensor to apply a different cali-
bration. Sheet two has the following columns:

Measurement Time: Date and time when the ProCheck made
the measurement.

Sensor Name: Type of sensor used for the measurement.
Unprocessed 1: Raw data for measurement 1
Unprocessed 2: Raw data for measurement 2.
Unprocessed 3: Raw data for measurement 3.

Sample ID: The optional annotation saved at the time of mea-
surement.

Calibration: The calibration used for soil moisture sensors.

Coef a to Coef f: The calibration coefficients you use to calcu-
late the measurement data.

Processed Data Text File (tab delimited)(*.txt): This file for-
mat creates a tab delimited text file of your measurement data.
This file type is useful if you do not have software that can read
Excel files (this format does not contain any of the raw sensor
data). The data appears in these columns.

Measurement Time: Date and Time when the ProCheck made
the measurement.

22



ProCheck 4 ECH20 UTILITY SOFTWARE

e Sensor Name: Type of sensor used for the measurement.

e Measurement 1: Primary measurement made by the sensor.
e Units 1: Units for measurement 1.

e Measurement 2: Some sensors support two measurements.
e Units 2: Units for measurement 2.

e Measurement 3: Some sensors support three measurements.
e Units 3: Units for Measurement 3.

e Sample ID: The optional annotation saved at the time of mea-
surement.

e Raw File (comma delimited)(*.csv): This file format contains
just the raw data the ProCheck stores. Save this type of file if
you need to send a raw file to Decagon to help in troubleshoot-
ing a data processing problem.

4.4 Data File Options

ECH20 Utility has several user preference options that help you
control how your data files. These options only apply to the Excel
Workbook and Processed Data Text file formats. To change these
options, open the ECH20 Utility preferences by choosing Preferences
from the Edit menu.

e Measurement Units: You can choose the units ECH20 Utility
uses to present your data. For example, you can choose °C or
°F for temperature measurements. Use the Measurement tab
to set your preferred units. Data units for data files come from
ECH20 Utility preferences, not the ProCheck settings.

e Column Headers: By default, ECH20 Utility writes column
headers to your data file. You can turn this feature off by
unselecting this option in the Data File tab of the ECH20
Utility Preferences.

e Date and Time Formatting in Data Files: ECH20 Utility uses
the Windows operating system settings for formatting date

23
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and time information (Regional & Language Options control
panel). You can override this formatting in the Data File tab
of the ECH20 Utility Preferences.

4.5 More ECH20 Utility Options

In addition to downloading data stored in your ProCheck, ECH20
Utility helps you manage your ProCheck with the following options.

Setting the Date and Time

ECH20 Utility automatically synchronizes the date and time of
your ProCheck to your computer time when you connect to your
ProCheck. You can manually synchronize the time by selecting Set
Date/Time from the Action menu.

4.6 Test Device Firmware

If you think your ProCheck is not operating correctly, you can check
the integrity of the firmware in your ProCheck. Firmware is the em-
bedded software that controls how your ProCheck functions. First,
establish a connection to your ProCheck then choose Test Device
Firmware from the Device Tools Sub Menu in the Actions menu.
Contact Decagon or your Decagon representative if your firmware
has become corrupt.

4.7 Check for Device Firmware Updates

You can use ECH20 Utility to check for updates to your ProCheck
firmware. Choose Check for Device Firmware Updates from the Help
menu to compare the firmware version in your ProCheck with the
latest version available from Decagon. Your computer must be con-
nected to the Internet for this feature to work. Decagon can improve
your ProCheck by publishing new versions of firmware to fix bugs or
add features.

24
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5 Troubleshooting and Repair

This chapter is in two sections. The first section is troubleshooting
ideas for resolving issues when using your ProCheck. The second
section is for troubleshooting software issues with ECH20 Utility.

Table 2: Troubleshooting Quick Guide

If this problem occurs: Refer to:
Troubleshooting the ProCheck

ProCheck does not power on Problem #1
ProCheck does not read Sensors Problem #2
ProCheck is not returning accurate readings Problem #3
Troubleshooting ProCheck Readings | Problem #4
ProCheck reports readings are above or be-

low range

ProCheck reports Invalid or No Response Problem #5
ProCheck returns inaccurate data Problem #6
Troubleshooting Serial Connections

ECH20 Utility says COM port busy Problem #7
USB-to-Serial adapter not showing in Com Port | Problem #8
picker

ECH20 Utility cannot connect to ProCheck Problem #9
ECH20 Utility reports it lost connection with de- | Problem #10
vice

ECH20 Utility reports no data to download Problem #11
ProCheck data file shows “* * *” Problem #12
Sensor data is incorrect Problem #13
Sensor data is incorrect Problem #12

Troubleshooting the ProCheck

To ensure operation of your ProCheck, please consider these help-

ful steps.

1. PROBLEM:
ProCheck does not have power.
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SOLUTION

Batteries: Be sure your ProCheck has sufficient battery power.
The ProCheck screen shows a battery icon in the upper right corner.
When the battery power is low, replace the batteries. You can also
use ECH20 Utility to check your battery power. Make sure you in-
sert the batteries in the correct orientation when replacing them.

2. PROBLEM:
SOLUTION

Sensors Plugged Securely: Check that your sensor connector is
fully engaged with the connector on the ProCheck.

3. PROBLEM:
ProCheck is not returning accurate readings.

SOLUTION

Be sure to select the correct sensor from the sensor menu on the
main screen. Making measurements with an incorrect sensor type
selected will create incorrect measurements.

Troubleshooting ProCheck Readings

4. PROBLEM:
My ProCheck display reads “Above Range” or “Below Range.”

SOLUTION

The ProCheck reads a value below or above the expected value for
the sensor. Check to make sure the sensor is plugged in and you
chose the correct sensor type. This message could also indicate a
broken sensor. Contact Decagon for assistance.

5. PROBLEM
My ProCheck says “Invalid Response” or “No Response” on the dis-

play.

26



ProCheck 5 TROUBLESHOOTING AND REPAIR

SOLUTION

The ProCheck cannot communicate with a digital sensor. Check
to make sure the sensor is plugged in and you selected the correct
sensor type. Try pressing the Enter button several times to restart
the sensor measurement. If these steps fail, the sensor is probably
broken, contact Decagon for repair or replacement.

6. PROBLEM
The data shown for my ProCheck seems incorrect.

SOLUTION

If you are using a custom calibration, be sure you entered the correct
coefficients in the Sensor Configuration menu. Check to make sure
the sensor type on the Main screen matches the sensor type plugged
into the ProCheck. If these steps do not resolve the problem, please
consult the sensor Operator’s manual.

Troubleshooting Serial Connections

7. PROBLEM
The ECH20 Utility tells me the communication port is in use by
another application, but no other programs are running.

SOLUTION

Some PDA synchronization programs monitor serial communication
ports. Disable Microsoft’s ActiveSync or Palm’s HotSync system
software when using ECH20 Utility on a serial port.

5. PROBLEM
My USB-to-Serial adapter does not show in the communication port
picker.

SOLUTION

27



5 TROUBLESHOOTING AND REPAIR ProCheck

Enable “Force find all Communication Ports” in the Preferences
Menu by going to the Edit Menu, clicking Preferences, then the
Communication tab, and enabling the check box at the bottom of
the screen. Enabling this option may find other serial ports unavail-
able for use by the ECH20 Utility (i.e. modems installed in your
computer).

8. PROBLEM
ECH20 Utility tells me it can not connect to my ProCheck.

SOLUTION
Try one or more of the following to make sure there is a serial con-

nection to your ProCheck.

e Check your serial port choice. Make sure the “Connect Via”
drop-down menu shows the name of the seProCheck

e Troubleshoot serial port to physically connect to your ProCheck.
For example, if your ProCheck is physically connected to COM1,
the “Connect Via” control should be set to “Direct on COM1
Communication Port.”

e Check that your serial cable is securely plugged into your ProCheck
and your computer.

e Make sure your ProCheck has good batteries.

9. PROBLEM
ECH20 Utility loses connection with my device.

SOLUTION

Please check or replace your serial cables. You can also increase
the number of times ECH20 Utility tries sending commands to the
ProCheck or DataStation. Also, increase the Direct Connect Retries
on the Communication tab of the Preferences form.

Troubleshooting Data Issues
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10. PROBLEM
ECH20 Utility tells me there is no data available for download.

SOLUTION

There is no measurement data stored in your ProCheck or your pre-
viously saved data was erased. To use measurement data collected
by the ProCheck on your computer. Be sure to press the Save button
on the ProCheck after each measurement to save data for later use.

11. PROBLEM

Some of the measurement data in my ProCheck data file shows
X

Wk ok

SOLUTION

The three asterisks means the data stored by the ProCheck is outside
the expected range for the sensor type. This could indicate a broken
sensor or inaccurate sensor type selection.

12. PROBLEM
My sensor data does not seem correct.

SOLUTION
There are many issues that impact the quality of sensor measure-

ments. Please see the sensor Operator’s manual for help troubleshoot-
ing the sensor.

5.1 Repair

Repair Instructions

If your ProCheck should ever require servicing contact support@Qdecag
on.com or call Decagon at (509) 332-5600. We need your address,

phone number, and your ProCheck serial number.

Before shipping your instrument to Decagon, please contact Decagon
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to obtain a Return Merchandise Authorization (RMA) number. This
allows Decagon’s repair staff to keep track of your ProCheck. Once
you have acquired an RMA, send your ProCheck to Decagon. Please
include a document listing the complete shipping address, name, and
department of the person responsible for the instrument, as well as a
description of the problem. This helps our technicians and shipping
department to expedite servicing on your ProCheck.

Please pack your ProCheck carefully. Ship it back in the carrying
case, preferably inside a cardboard box. Ship to:

Decagon Devices, Inc.
RMA# (insert number here)
2365 NE Hopkins Court
Pullman, WA 99163

Repair Costs
Decagon repairs products with manufacturer’s defects and those un-

der warranty at no cost to the customer. For non-warranty repairs,
we bill the customer for the cost of parts, labor, and shipping.
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6 Appendix A

6.1 Compatible Sensors

The ProCheck is only compatible with sensors made by Decagon.
This appendix gives a list of compatible sensors.

To learn more about individual sensors and their respective calibra-
tions, please visit http://www.decagon.com/support/sensor-calibrati
on-master-list.

Soil Water Content Sensors

10HS, EC-5, GS1 High Frequency Soil Moisture
5TM Soil Moisture and Soil Temperature
5TE, GS3, RS3 Soil Moisture, Soil Temperature, Soil EC

Soil Water Potential Sensors

MPS-2, MPS-6 Water Potential and Temperature
LWS Leaf Wetness

Temperature Sensors
ECT Air Temperature
RT-1 Rugged Soil Temperature

Rain Gauges

ECRN-50 Low Resolution Rain Gauge

ECRN-100 High Resolution Rain Gauge
Temperature and Relative Humidity

VP-3 Temp, Relative Humidity, and Vapor Pressure

Radiation Sensors
PYR Solar Radiation

QSO-S PAR Photon Flux
SRS-Ni, SRS-Nr, SRS-Pi, SRS-Pr Solar Reflectance
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Wind Sensor

Davis Cup Anemometer
DS-2 Sonic Anemometer
G2/G3 Drain Gauge
Irrigation Switch

PS-1 Pressure Switch

Water Level Sensors

Drain Gauge G3, Deep Drainage, Temperature, and Electrical Con-
ductivity

CTD-5, Water Level, Temperature, and Electrical Conductivity
CTD-10, Water Level, Temperature, and Electrical Conductivity
CTD, Water Level, Temperature, and Electrical Conductivity

Miscellaneous Sensors

ECRN-50 Volume

Millivolt (0-3000 mV input)

Millivolt (0-1500 mV input)

Pulse Counter

Flow Meter

ES-2, ES-2F Electrical Conductivity and Temp
Leaf Wetness Sensor

Discontinued Sensors

EC-10, EC-20 Classic Soil Moisture

EC-TM Soil Moisture and Temperature

ECH20-TE Soil Moisture, Soil Temperature, Soil EC
MPS-1 Dielectric Water Potential

EHT Temperature/RH Sensor
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7 Appendix B

7.1 Sending Feedback

Decagon Software makes it easy to send feedback, bug reports, and
feature requests to Decagon or your Decagon Distributor. Choose
“Send Feedback to Decagon...” from the Help menu. This opens the
Send Feedback to Decagon window.

% Send Feedback to Decagon El
Hame (required) Comparry Mame
Lea Cole SirkHole Farms
Email Address Telephane (indude ares cods)
leeoi@sinkholef sreng, org B00-555-3322
Type of fesdbadk PFlease respond via
Gereral Feedback, » | |Email “

Flease dascribe the feadback below

Decagon software warks great, everytime,

Send the falowing fe:

[Clindude ECHZO Ltilty errer log filles

Sard the feedback to my Decagon Represantative's emal address:

Figure 1: Send Feedback to Decagon

Enter your name, company name, and other contact information.
Tell us what type of feedback you are sending (General Feedback,
Feature Suggestions, Bug Report, or Other). Indicate how you want
us to respond to your feedback (E-mail or Telephone).

Use the description area to give details for your feedback. If you
are reporting a bug, it is very helpful for you to tell us what steps
you took for the bug to happen and any error message you saw. By
default, bug reports also include the software error files.
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7 APPENDIX B ProCheck

You can send Decagon a file using this form too. This is useful
for sending data files that you have questions about. If you work
directly with a Decagon representative, put their E-mail address in
the field at the bottom of the form.

This sends the contents of the form to them. Your Decagon rep-
resentative can follow-up with you directly.
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8 Declaration of Conformity

Application of Council Directive: 2004/108/EC and 2011/65/EU

Standards to which conformity is EN 61326-1:2013 and

declared:
EN 50581:2012

Manufacturer’s Name: Decagon Devices, Inc 2365 NE
Hopkins Ct. Pullman, WA 99163
USA

Type of Equipment: ProCheck

Model Number: PC-1

Year of First Manufacture: 2007

The undersigned hereby declares on behalf of Decagon Devices, Inc.
that the above referenced products, to which this declaration relates,
fully conform to the provisions of the Council Directives and stan-
dards referenced above.

Michael Wadsworth
Engineering Director
7-9-2015
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